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          Adobe Acrobat Reader 

Finding Words

You can use the Find command to find a complete word or part of a word in the current PDF document.  Acrobat Reader looks for the word by reading every word on every page in the file, including text in form fields.

To find a word using the Find command:

1. Click the Find button (Binoculars), or choose Edit > Find.

2. Enter the text to find in the text box.

3. Select search options if necessary:

Match Whole Word Only finds only occurrences of the complete word you enter in the box.  For example, if you search for the word stick, the words tick and sticky will not be highlighted.

Match Case finds only words that contain exactly the same capitalization you enter in the box.

Find Backwards starts the search from the current page and goes backwards through the document.

4. Click Find.  Acrobat Reader finds the next occurrence of the word.

To find the next occurrence of the word, Do one of the following:

            Choose Edit > Find Again 

            Reopen the find dialog box, and click Find Again. 
            (The word must already be in the Find text box.)

Copying and pasting text and graphics to another application

You can select text or a graphic in a PDF document, copy it to the Clipboard, and paste it into another application such as a word processor.  You can also paste text into a PDF document note or into a bookmark.  Once the selected text or graphic is on the Clipboard, you can switch to another application and paste it into another document.  

Note:  If a font copied from a PDF document is not available on the system displaying the copied text, the font cannot be preserved.  A default font  is substituted.

To select and copy it to the clipboard:

1. Select the text tool T, and do one of the following:

       To select a line of text, select the first letter of the sentence or phrase and drag to
       the last letter.  

To select multiple columns of text (horizontally), hold down Ctrl+Alt (Windows) or Option (Mac OS) as you drag across the width of the document. 

To select a column of text (vertically), Hold down Ctrl+Alt (Windows) or Option+Command (Mac OS) as you drag the length of the document.

To  select all the text on the page, choose Edit > Select All.  In single page mode, all the text on the current page is selected.  In Continuous or Continuous – facing mode, most of the text in the document is selected.  When you release the mouse button, the selected text is highlighted.  To deselect the text and start over, click anywhere outside the selected text.  

The Select All command will not select all the text in the document.  A workaround for this (Windows) is to use the Edit > Copy command.  Choose Edit > Copy to copy the selected text to the clipboard.

2. To view the text, choose Window > Show Clipboard

In Windows 95, the Clipboard Viewer is not installed by default and you cannot use the Show Clipboard command until it is installed.  To install the Clipboard Viewer, Choose Start > Settings > Control Panel > Add/Remove Programs, and then click the Windows Setup tab.  Double-click Accessories, check Clipboard Viewer, and click OK.

[There was no reportable action taken as a result of

the Board of Supervisors' closed session held today.]
SUP. KNABE, CHAIRMAN: WELCOME. WE'RE GOING TO BEGIN THE MEETING THIS MORNING WE'LL BE LED IN OUR INVOCATION BY A GOOD FRIEND MINISTER RON ROBERSON, CHAPEL OF CHANGE CHRISTIAN FELLOWSHIP IN PARAMOUNT. FOLLOWED BY THE PLEDGE OF ALLEGIANCE WHICH WILL BE LED BY DONNY GIST, FORMER MEDICAL SERGEANT, UNITED STATES ARMY, SHERMAN OAKS. PASTOR RON? 

MINISTER RON ROBERSON: LET US TAKE A MOMENT TO REFLECT IN OUR OWN WAY AND IN ACCORDANCE WITH OUR OWN INDIVIDUAL BELIEFS. WE COME THANKING YOU AND PRAISING YOU FOR OUR GREAT COUNTRY. I THANK YOU FOR THE PLAN YOU GAVE OUR FOREFATHERS BY WHICH TO GOVERN OUR CITY AND FOR THE DIVISION OF POWERS SO THAT OUR DESTINY DOES NOT LIE IN THE HANDS OF ONE PERSON. I'M PRAYING FOR THOSE IN AUTHORITY. I THEREFORE LIFT UP OUR BOARD OF SUPERVISORS. I ASK THAT YOU GIVE THEM THE WISDOM TO MAKE DECISIONS THAT WOULD STRENGTHEN AND PROSPER OUR COUNTRY. I DESIRE THAT THEY WOULD MAKE THE RIGHT DECISIONS CONCERNING POLITICS, THE SOCIAL WELFARE AND THE ECONOMICS OF OUR COUNTY. I ASK THAT YOU GUIDE AND GOVERN EVERYTHING WITH ORDER AND LOVE. LOOK UPON THIS ASSEMBLY OF OUR LEADERSHIP AND FILL THEM WITH YOUR SPIRIT AND WISDOM. MAY THEY ALWAYS ACT IN ACCORDANCE WITH YOUR WILL AND THEIR DECISIONS ARE BASED ON THE PEACE AND SAFETY AND WELL-BEING OF ALL. THIS WE ASK WITH GREAT HUMILITY AND GRATITUDE. THANK YOU. 

DONNIE GIST: GOOD MORNING, ALL, IF YOU COULD PLEASE PLACE YOUR RIGHT HAND OVER YOUR HEART, FACING THE FLAG AND RECITE THE PLEDGE OF ALLEGIANCE WITH ME. [PLEDGE OF ALLEGIANCE RECITED.] 

SUP. KNABE, CHAIRMAN: LET ME BEGIN BY THANKING ONCE AGAIN MINISTER RON ROBERSON FOR GIVING THE INVOCATION THIS MORNING. HE IS FROM, AS I MENTIONED, CHAPEL OF CHANGE CHRISTIAN FELLOWSHIP IN PARAMOUNT. HE'S BEEN IN THE MINISTRY FOR OVER 30 YEARS, WAS ORDAINED IN SAN DIEGO BY BISHOP J.A. BLAKE SR. AND THE CHURCH OF GOD IN CHRIST. HE ALSO HAS SERVED AS PASTOR OF THE ON FIRE CHRISTIAN FELLOWSHIP AND HAS WORKED AS CHAPLAIN PASTOR FOR THE UNION RESCUE MISSION HERE IN LOS ANGELES AND ALSO SERVED AS A REPORTER PRODUCER C.N.N. HEADLINE LOCAL EDITION. HE IS A TWO-TIME EMMY NOMINEE AND HE WON AN EMMY IN 1992 FOR "GANG FACTS, WHAT EVERY PARENT SHOULD KNOW". SO IT'S MY PLEASURE TO THANK MINISTER RON AND A GOOD FRIEND WHO HAS TAKEN THE TIME TO LEAD US IN THE INVOCATION. 

RON ROBERSON: THANK YOU. [APPLAUSE.] 

SUP. KNABE, CHAIRMAN: NOW I'D LIKE TO PRESENT A CERTIFICATE OF APPRECIATION ON BEHALF OF SUPERVISOR YAROSLAVSKY TO DONNY GIST, A FORMER MEDICAL SERGEANT, UNITED STATES ARMY FROM SHERMAN OAKS, AND THANK HIM FOR TAKING THE TIME TO COME DOWN AND LEAD US IN OUR PLEDGE OF ALLEGIANCE. HE'S ALSO A HOMELESS VETERAN PROGRAM ELIGIBILITY SPECIALIST WORKING OUT OF THE WEST LOS ANGELES V.A. SO WE THANK YOU FOR YOUR SERVICE TO AMERICA. WE THANK YOU FOR YOUR ONGOING SERVICE TO OUR VETERANS, AND GODSPEED. THANK YOU. [APPLAUSE.] 

SUP. KNABE, CHAIRMAN: I'M EXTREMELY HONORED THIS MORNING TO WELCOME AND HAVE HERE WITH US CALIFORNIA SUPREME COURT JUSTICE MARVIN BAXTER. WE ARE HONORED TO HAVE HIM HERE TODAY AND TO A CELEBRATION OF A LIFETIME OF EXEMPLARY PUBLIC SERVICE. JUSTICE BAXTER COMMENCED HIS LEGAL CAREER IN 1967 SERVING TWO YEARS AS A FRESNO COUNTY DEPUTY DISTRICT ATTORNEY. HE ALSO PRACTICED CIVIL LAW FOR 13 YEARS IN A FRESNO LAW FIRM. FIRST AS AN ASSOCIATE AND LATER AS A PARTNER. 1983, MANY OF US REMEMBER THAT DAY, HE BECAME APPOINTMENT SECRETARY FOR THEN GOVERNOR GEORGE DEUKMEJIAN. SERVING AS PRINCIPAL ADVISER OF ALL GUBERNATORIAL APPOINTMENTS MADE TO THE EXECUTIVE AS WELL AS JUDICIAL BRANCHES OF GOVERNMENT. IN HIS SIX YEARS AT THAT POSITION, HE ASSISTED IN THE APPOINTMENT OF OVER 700 JUDGES. IN 1988, HE WAS APPOINTED AS AN ASSOCIATE JUSTICE TO THE COURT OF APPEALS AND THEN IN 1991, HE WAS APPOINTED AS ASSOCIATE JUSTICE OF THE SUPREME COURT OF THE GREAT STATE OF CALIFORNIA. HIS TERM IS UP IN 2015. HE HAS ANNOUNCED HIS RETIREMENT AND WILL HAVE SERVED IN THAT DISTINGUISHED CAREER FOR SOME 24 YEARS. SO I WOULD ONLY ADD AS A FRIEND OVER THE MANY, MANY YEARS AND WORKING HERE WITH HIM IN VARIOUS CAPACITIES, HE'S AN INCREDIBLE PUBLIC SERVANT, A MAGNIFICENT JUDGE, AND HAS GIVEN HIS ALL TO THE GREAT STATE OF CALIFORNIA. WE WANT TO WISH HIM AND HIS WIFE THE BEST IN RETIREMENT. I KNOW HE'S NOT GOING TO SHUT EVERYTHING DOWN BECAUSE HE ALREADY TOLD ME THE LITTLE THINGS HE'S GOT PLANNED. BUT WE WANT THE THANK HIM FOR HIS SERVICE TO THE GREAT STATE OF CALIFORNIA AND TO THE UNITED STATES OF AMERICA. CONGRATULATIONS AND BEST WISHES. [APPLAUSE.] 

HON. MARVIN BAXTER: THANK YOU VERY MUCH, MR. CHAIRMAN AND MEMBERS OF THE BOARD OF SUPERVISORS, I WANT TO EXPRESS MY SINCERE APPRECIATION FOR THE RECOGNITION. I MUST SAY THAT 32 YEARS -- 32 CONSECUTIVE YEARS OF PUBLIC SERVICE IS VERY FULFILLING. AND I KNOW I'M PREACHING TO THE CHOIR HERE BECAUSE MANY MEMBERS OF THE BOARD AND OTHERS IN STAFF POSITIONS HAVE LIKEWISE DEVOTED THEIR LIVES AND THEIR CAREERS TO PUBLIC SERVICE. AND I COMMEND YOU FOR THAT. I ACCEPT THIS RECOGNITION AS COMMUNITY PROPERTY. MY WIFE JANE WHO'S HERE, WE WERE MARRIED BEFORE I STARTED LAW SCHOOL BACK IN 1963. SO SHE WORKED AS AN ELEMENTARY SCHOOL TEACHER AS I WENT THROUGH LAW SCHOOL. SO SHE'S BEEN VERY MUCH AN IMPORTANT PART OF MY CAREER. SO ONCE AGAIN, I KNOW YOU HAVE A VERY FULL AGENDA. I WANT TO EXPRESS MY SINCERE APPRECIATION. THANK YOU VERY MUCH. [APPLAUSE.] 

SUP. KNABE, CHAIRMAN: AT THIS TIME I'D LIKE TO CALL UP CAPTAIN DAYTON CALHOUN FROM THE LOS ANGELES COUNTY FIRE DEPARTMENT. CAPTAIN CALHOUN IS ALSO A FORMER LIEUTENANT IN THE UNITED STATES MARINE CORPS AND TODAY WE ARE PROCLAIMING SEPTEMBER 11, 2014, AS A NATIONAL DAY OF SERVICE AND REMEMBRANCE. CAPTAIN CALHOUN SERVED AS A NAVAL AVIATOR FLYING SUPER COBRA ATTACK HELICOPTERS. HE ALSO SERVED AS A FORWARD AIR CONTROLLER AND AIR OFFICER FOR GROUND UNITS IN THE THIRD MARINE DIVISION AS WELL AS A THIRD PLATOON SEAL TEAM 3 AND THE FIRST PLATOON, FIRST RECONNAISSANCE. HIS DEPLOYMENTS INCLUDED OKINAWA, KOREA, SOMALIA, EAST TIMORE, IRAQ AND BAHRAIN. AFTER HE RETIRED FROM MARINES AND OBTAINED HIS MASTER'S DEGREE, HE EMBARKED -- THIS IS A UNIQUE TRANSITION THAT YOU HAD HERE -- AFTER HE GOT HIS MASTER'S DEGREE, EMBARKED ON A PATH TO A CAREER IN THE FINANCIAL SECTOR. HE WAS NOT PARTICULARLY LOOKING FORWARD TO A JOB WORKING BEHIND THE DESK, A LITTLE BIT DIFFERENT THAN A COBRA; RIGHT? AND HE WAS GREATLY IMPRESSED BY THE PRIDE THAT HE HAD SEEN IN THE FIREFIGHTERS AFTER HELPING SOMEONE. HE ADMIRED THEIR PROFESSIONALISM AND DEDICATION AND THAT THEY HAD JUST SERVING THE COMMUNITY AROUND THEM. SO HE, TOO, WANTED THAT OPPORTUNITY TO SERVE HIS COMMUNITY. SO HE DECIDED THAT THAT IS WHAT HE WANTED AND NEEDED TO DO AND THE REST IS HISTORY. HE REPRESENTS THE SPIRIT OF PATRIOTISM, SERVICE AND LOYALTY. AND ALSO AS WE RECOGNIZE THIS NATIONAL DAY OF REMEMBRANCE AND SERVICE, WE ALL PAINFULLY REMEMBER THE SERIES OF TERRORIST ATTACKS AND CAN REMEMBER EXACTLY WHERE WE WERE WHEN THEY WERE PERPETRATED AGAINST THE COUNTRY, THE GREAT UNITED STATES OF AMERICA ON SEPTEMBER 11, 2001. THE ATTACKS CAUSED THE DEATHS OF OVER 3,000 INNOCENT PEOPLE INCLUDING MORE THAN 400 OFFICERS, POLICE OFFICERS AND FIREFIGHTERS. THE EVENTS OF SEPTEMBER 11TH WILL ALWAYS BE A DEFINING MOMENT IN OUR HISTORY, INSPIRING CITIZENS TO RENEW THE SPIRIT OF UNITY, COMPASSION AND SELFLESSNESS, DEMONSTRATED IN THE AFTERMATHS OF THE ATTACKS BY UNITING TO REMEMBER THOSE WHO PERISHED, HELP THOSE THAT ARE SUFFERING, HONOR THE VALIANT POLICE AND FIRE AND EMERGENCY PERSONNEL AND RECOGNIZE THE MEMBERS OF THE ARMED FORCES WHO CONTINUE TO SERVE AND SERVED THEN WITH THE COURAGE BOTH AT HOME AND ABROAD. SO LET THIS BE AN OPPORTUNITY ONCE AGAIN TO SALUTE THE HEROES OF 9/11, RECAPTURE THE SPIRIT OF UNITY AND COMPASSION AND INSPIRED OUR NATION FOLLOWING THE ATTACKS AND REDEDICATE OURSELVES TO SUSTAINED SERVICE TO OUR COMMUNITY. SO ON BEHALF OF THE COUNTY BOARD OF SUPERVISORS, WE'D LIKE TO PRESENT THIS SCROLL TO CAPTAIN DAYTON CALHOUN IN RECOGNIZING SEPTEMBER 11, 2014 AS A NATIONAL DAY OF SERVICE AND REMEMBRANCE AND URGE ALL COUNTY CITIZENS TO JOIN IN THAT SERVICE AND HONOR THE LIVES THAT WE LOST, THE HEROES WHO RESPONDED IN OUR TIME OF NEED AND THE BRAVE MEN AND WOMEN IN UNIFORM WHO CONTINUE TO BE IN HARM'S WAY TO PROTECT THE COUNTRY BOTH AT HOME AND ABROAD. [APPLAUSE.] 

CAPTAIN DAYTON CALHOUN: THANK YOU, MR. CHAIRMAN, BOARD OF SUPERVISORS. I CAME IN TO THE MARINE CORPS AT A TIME IN THE '80S WHERE WE WEREN'T IN AN ACTIVE CONFLICT. AND SINCE THEN, SINCE 9/11, SEPTEMBER 11, 2001, WE'VE BEEN IN ACTIVE CONFLICT IF NOT AN ALL-OUT WAR. AND SO WHILE WE STILL HAVE A VOLUNTEER FORCE, IT SAYS SOMETHING ABOUT THE CHARACTER OF THE MEN AND WOMEN THAT ENLIST TODAY AND THEIR FAMILIES AND COMMUNITIES THEY COME FROM, THAT THEY KNOW WHEN THEY ENLIST, THEY'RE GOING TO BE IN ACTIVE CONFLICT. SO I'D LIKE TO THANK ALL THE PARENTS AND FAMILIES THAT SUPPORT ALL OUR CURRENT VETERANS AND ALL OF OUR ACTIVE DUTY AND RESERVISTS. SO THANK YOU VERY MUCH. I'D ALSO LIKE TO THANK THE COUNTY OF LOS ANGELES FOR THE GREAT SUPPORT THEY GIVE, ACTIVE DUTY RESERVISTS AND THE VETERANS THAT ARE EMPLOYED BY THE COUNTY. I CAN'T IMAGINE NOT WORKING FOR AN ORGANIZATION THAT GIVES US THIS KIND OF SUPPORT. SO THANK YOU VERY MUCH FOR ALL THAT YOU DO FOR ALL OF US ACTIVE AND RETIRED VETERANS. SO THANK YOU VERY MUCH. [APPLAUSE.] 

SPEAKER: ON BEHALF OF THE MEN AND WOMEN IN THE DEPARTMENT OF MILITARY AND VETERANS AFFAIRS, WE THANK CAPTAIN DAVID CALHOUN FOR HIS SERVICE TO HIS COUNTRY AND FOR SELECTING THE COUNTY OF LOS ANGELES TO CONTINUE HIS SERVICE TO THE MEN AND WOMEN OF OUR COUNTY AND OUR COUNTRY. THANK YOU. 

SUP. KNABE, CHAIRMAN: NOW I'M GOING TO ASK THE ONE AND ONLY JUDGE MICHAEL NASH TO JOIN ME UP HERE ALONG WITH OUR D.C.F.S. CHIEF DEPUTY DAVENPORT TO CELEBRATE FAMILY REUNIFICATION WEEK HERE IN LOS ANGELES COUNTY. UNFORTUNATELY, THE MANNER IN WHICH THE MEDIA REPORTS ABOUT THE CHILD WELFARE SYSTEM THESE DAYS DOES NOT LEAVE A LOT OF ROOM TO LOOK AT THE SUCCESS STORIES, THE PEOPLE IN DIFFICULT CIRCUMSTANCES WHO SOMEHOW FOUND THE COURAGE AND THE WILL TO OVERCOME THEM AND KEEP THEIR FAMILIES TOGETHER. TODAY, WE HAVE FIVE SUCH EXAMPLES OF THIS VERY SPECIAL KIND OF RESILIENCE. FIRST OF ALL, I WOULD LIKE TO START WITH THE HONOREE FROM THE FOURTH DISTRICT, MRS. ANGELA DEL ZAL. SHE LOST CUSTODY OF HER THREE CHILDREN WHILE STRUGGLING WITH MENTAL HEALTH ISSUES. BUT RATHER THAN MAKING EXCUSES OR FEELING SORRY FOR HERSELF, SHE STEPPED UP. WITH THE ASSISTANCE AND SUPPORT OF HER PARENT PARTNER, ANGELA WAS FORTHRIGHT IN ADDRESSING HER SENSITIVE ISSUES. SHE QUICKLY ENROLLED IN ALL OF HER REQUIRED CLASSES. SHE MADE VISITS WITH HER CHILDREN HER NUMBER 1 PRIORITY, GIVING THEM HER FULL ATTENTION. AND AS A RESULT OF ALL HER CONSCIENTIOUS EFFORT, SHE WAS REUNITED WITH HER CHILDREN THIS PAST MARCH. I THINK WHAT WE APPRECIATE MOST ABOUT THIS STORY IS THAT SHE IS PAYING IT FORWARD BY NOW FACILITATING GROUPS AT THE AGENCY SHE WAS INVOLVED WITH. SO CONGRATULATIONS, ANGELA. WE WISH YOU ALL THE VERY BEST. [APPLAUSE.] SUPERVISOR MOLINA, I THINK YOU'RE NEXT. 

SUP. MOLINA: WELL, I WANT TO JOIN WITH SUPERVISOR KNABE AND ALL OF MY COLLEAGUES TO REMIND EVERYONE, AS WELL, THAT THERE ARE MANY VERY POSITIVE STORIES IN OUR DEPARTMENT OF CHILDREN AND FAMILY SERVICES AND, MORE IMPORTANTLY, THERE ARE SOME TERRIFIC SOCIAL WORKERS THAT ASSIST MANY OF THESE PARENTS THROUGH THESE VERY TOUGH AND TROUBLING TIMES. BUT ANGEL RAMIREZ, WHO IS STANDING NEXT TO ME HERE, IS A PERFECT EXAMPLE OF HOW THE SYSTEM CAN WORK ON THEIR BEHALF. HE WAS A SINGLE PARENT WHO HAS OVERCOME AN 18-YEAR HISTORY OF SUBSTANCE ABUSE, BUT HE REUNITED WITH HIS FOUR BOYS. AT A LOW POINT, HE AND HIS CHILDREN WERE LIVING IN MOTELS, BUT HE TOOK ADVANTAGE OF THE ESSENTIAL D.C.F.S. RESOURCES TO BEGIN TO HEAL HIS FAMILY. WHILE ATTENDING COUNSELING AT BEYOND SHELTER AND FIRST FIVE L.A., HE HELPED COORDINATE THE MAZE OF SERVICES NEEDED TO FIND A PERMANENT HOME FOR HIS FAMILY AND TO ENSURE HIS SOBRIETY. MR. RAMIREZ IS AN ACTIVE PARTICIPANT IN NARCOTICS ANONYMOUS. HE ENCOURAGES OTHERS TO ADDRESS THEIR SUBSTANCE ABUSE ISSUES AND TO STRIVE TO KEEP THEIR FAMILIES TOGETHER AND UNITED. THE CITY OF L.A. RECENTLY RECOGNIZED MR. RAMIREZ FOR A SUCCESSFUL REUNIFICATION EFFORT AND RECOGNIZED HIS WORTHY COMMUNITY SERVICE, AS WELL. SO MR. RAMIREZ, WE WANT TO THANK YOU SO MUCH. CONGRATULATIONS TO YOU AND WE'RE SO GLAD THAT THIS PROGRAM WORKED FOR YOU. YOU ARE A GOOD EXAMPLE FOR EVERYONE ELSE. [APPLAUSE.] 

SUP. KNABE, CHAIRMAN: SUPERVISOR RIDLEY-THOMAS? MR. CHAIRMAN AND COLLEAGUES, WE TAKE THIS OPPORTUNITY TO ACKNOWLEDGE THE TREMENDOUS WORK OF DELLA HILL. IN 1972, THE ASIAN AMERICAN DRUG ABUSE PROGRAM, A NONPROFIT ORGANIZATION THAT HAS BEEN PROVIDING PREVENTION, EDUCATION, TREATING SUBSTANCE ABUSE AND FACILITATING ECONOMIC DEVELOPMENT TO INCREASE JOB SKILLS AND EMPLOYMENT FOR THE UNDERSERVED COMMUNITIES. FOR THE PAST 17 YEARS, MS. HILL, A CASEWORKER WITH THE ASIAN AMERICAN DRUG ABUSE PROGRAM, OTHERWISE KNOWN AS A.D.A.P., HAS BEEN CONSCIENTIOUSLY SUPPORTING MOTHERS TO OVERCOME THEIR DRUG ADDICTIONS SO THAT THEY MAY BE REUNITED WITH THEIR CHILDREN THROUGH DEPENDENCY COURT. THROUGH EXTENSIVE COUNSELING, SHE HELPS MOTHERS FIRST RECOGNIZE HOW THEIR MALADAPTIVE BEHAVIORS ARE NEGATIVELY IMPACTING THEIR FAMILIES. SHE EDUCATES HER CLIENTS ON HOW TO USE NEW, HEALTHIER PARENTING SKILLS THAT MAKE THEM FEEL BETTER ABOUT THEMSELVES AND HELP THEM COPE WITH DIFFICULT SITUATIONS WHILE INSURING THAT THEIR CHILDREN ARE SAFE. MISS HILL IS A DEDICATED ADVOCATE FAMILIAR WITH COMPLEXITIES OF THE DEPENDENCY COURT SYSTEM. SHE EXPLAINS TO HER CLIENTS HOW TO BEST NAVIGATE THROUGH COURT AND D.C.F.S. REQUIREMENTS, HELPING THEM TO REUNIFY WITH THEIR CHILDREN. SHE WORKS FROM A STRENGTH-BASED PERSPECTIVE TO DEVELOP A TRUSTING RELATIONSHIP WITH HER CLIENTS, INCREASING THE LIKELIHOOD OF SUCCESS. SO WE WISH TO SAY THANK YOU FOR BEING SUCH A STRONG AND DEDICATED ADVOCATE FOR OUR CHILDREN AND THEIR FAMILIES. AND WE DELIGHT IN PRESENTING THIS SCROLL TO MS. DELLA HILL. GIVE HER A BIG ROUND OF APPLAUSE, WON'T YOU? [APPLAUSE.] 

SUP. KNABE, CHAIRMAN: THANK YOU VERY MUCH. NEXT ON BEHALF OF SUPERVISOR YAROSLAVSKY, I'M PRESENTING TO MS. AMBER ROSE PRIOR TO ENTERING THE D.C.F.S. SYSTEM AS A PARENT, THE ODDS WERE ALREADY STACKED AGAINST HER. BOTH HER MOTHER AND GRANDMOTHER WERE INVOLVED WITH THE CHILD WELFARE SYSTEM; AND AS A CHILD, AMBER SPENT MANY YEARS IN FOSTER CARE. MS. ROSE TRANSITIONED OUT OF FOSTER CARE AS A TEENAGE PARENT. BUT THE GENERATIONAL CYCLE OF FAMILY ABUSE IN THE FORM OF SUBSTANCE ABUSE EVENTUALLY CAUGHT UP WITH HER. SHE FOUND HERSELF OVERWHELMED AND ILL EQUIPPED TO CARE FOR HER THREE CHILDREN. BUT SHE DID FIND THE STRENGTH AND PRESENCE OF MIND TO CONTACT OUR D.C.F.S. SEEKING HELP. MS. ROSE ADMITTED HERSELF INTO VIA AVANTA A RESIDENTIAL TREATMENT PROGRAM FOR WOMEN IN PACOIMA AND WITH THE SUPPORT OF HER CASE CARING SOCIAL WORKER SHARON O'BRIEN SHE WAS SUCCESSFUL IN RESOLVING HER ISSUES AND REUNIFIED WITH HER CHILDREN. MRS. ROSE NOW IS THE LEAD PARENT PARTNER WITH THE PARENTS AND PARTNERSHIP PROGRAM FOR THE CHATSWORTH D.C.F.S. OFFICE. THROUGH HER WORK SHE IS ABLE TO SHARE HER STORY WITH OTHER PARENTS WITH THE GOAL OF INSPIRING OTHER PARENTS TO FOLLOW IN HER FOOTSTEPS TO SUCCESS. MRS. ROSE HAS ALSO BECOME A VERY POPULAR SPEAKER IN THE COMMUNITY AND IS IN CONSTANT DEMAND. HER PASSION FOR ENCOURAGING OTHERS TO ENGAGE IN RECOVERY AND TO FIND THEIR WAY TOWARDS REUNIFICATION WITH THEIR CHILDREN IS WHAT SET HER APART AS A MODEL AND OUR HERO. SO PLEASE JOIN ME IN CONGRATULATING MS. AMBER ROSE, THIRD DISTRICT'S FAMILY REUNIFICATION HERO OF 2014. [APPLAUSE.] 

SUP. KNABE, CHAIRMAN: NEXT, I'M PRESENTING ON BEHALF OF SUPERVISOR ANTONOVICH, AS WELL. WE'D LIKE TO PRESENT THE HONOREE FROM THE FIFTH DISTRICT, TAHASHA RICHMOND. MRS. RICHMOND IS DEAF. AND WITH FOUR SPECIAL NEEDS CHILDREN OF HER OWN, HER SITUATION WAS VERY PROBLEMATIC. HER CASE WAS HANDLED BY THE D.C.F.S. DEAF SERVICES UNIT AND SOCIAL WORKER LEEANNE UNCHANGO AND WAS ABLE TO COMMUNICATE WITH MRS. RICHMOND AND ALSO ENCOURAGE HER CHILDREN TO LEARN AMERICAN SIGN LANGUAGE. WITH THIS VERY VITAL SUPPORT IN PLACE, SHE HAD A BETTER UNDERSTANDING OF HER CHILDREN'S SPECIAL NEEDS AND WAS PROVIDED THE TOOLS AND SERVICES TO PROPERLY CARE FOR HER FAMILY. SHE MADE SIGNIFICANT PROGRESS AND EARLIER THIS YEAR HER YOUNGER CHILDREN WERE RETURNED TO HER CARE AND HER COURT CASE WAS CLOSED. MRS. RICHMOND ACKNOWLEDGES THAT SHE COULD NOT HAVE DONE THIS WITHOUT THE SUPPORT OF HER SOCIAL WORKER AND JUVENILE COURT ALSO ASSISTED IN HELPING HER UNDERSTAND WHAT WAS HAPPENING AT HER COURT HEARINGS BY PROVIDING AN AMERICAN SIGN LANGUAGE INTERPRETER. CONGRATULATIONS TO DISTRICT 5'S HERO, TAHASHA RICHMOND. [APPLAUSE.] 

SUP. KNABE, CHAIRMAN: AND NOW THE GENTLEMAN WHO WORKED SO HARD OVER THE YEARS TO MAKE DAYS LIKE THIS HAPPEN, MORE IMPORTANTLY MAKE FAMILIES REUNIFY IS JUDGE MICHAEL NASH. WE'D LIKE TO PRESENT JUDGE NASH OF THIS SCROLL AND RECOGNITION OF THIS VERY SPECIAL TIME IN OUR COUNTY AND TO ASK JUDGE NASH TO SAY A FEW WORDS. JUDGE MICHAEL NASH. [APPLAUSE.] 

JUDGE MICHAEL NASH: THANK YOU, MR. CHAIRMAN. ON BEHALF OF THE JUVENILE COURT AND ALL OUR PARTNERS, THAT BEING THE DEPARTMENT OF CHILDREN AND FAMILY SERVICES, COUNTY COUNSEL, LOS ANGELES DEPENDENCY LAWYERS INCORPORATED AND THE CHILDREN'S LAW CENTER OF LOS ANGELES, I WANT TO CONGRATULATE ALL OF TODAY'S HONOREES. AND AS ALWAYS, WE WANT TO THANK THE BOARD OF SUPERVISORS FOR THEIR SUPPORT OF THIS VERY IMPORTANT WORK WE DO. THANK YOU. [APPLAUSE.] 

FESIA DAVENPORT: THANK YOU, JUDGE NASH. ON BEHALF OF MY DIRECTOR, PHILIP BROWNING, THANK YOU TO THE CHAIR AND TO THE BOARD AND TO THE C.E.O. FOR RECOGNIZING THIS WEEK AS FAMILY REUNIFICATION WEEK. SO MANY TIMES WE HEAR STORIES ABOUT THE DEPARTMENT OR CHILDREN AND FAMILIES. THIS IS ONE OF THOSE STORIES THAT WE FEEL THAT EVERYONE SHOULD KNOW ABOUT AND EVERYONE SHOULD SHARE BECAUSE THIS IS THE HARD WORK THAT WE DO DAY IN AND DAY OUT. WE KNOW THAT CHILD SAFETY AND CHILD PROTECTION IS A TOUGH BUSINESS, BUT THESE ARE OUR SUCCESS STORIES. EVERY YEAR WE REUNIFY OVER 6,000 FAMILIES. AND OVER THE LAST 10 YEARS, WE'VE REUNIFIED ABOUT 60,000 FAMILIES. SO IN ADDITION TO ACKNOWLEDGING THE SOCIAL WORKERS, THE DEPENDENCY LAWYERS, THE CHILDREN'S LAWYERS, COUNTY COUNSEL, OUR CHILDREN'S ADVOCATES, I WOULD ALSO LIKE TO ONCE AGAIN RECOGNIZE AND GIVE A NICE ROUND OF APPLAUSE FOR ALL OF OUR FAMILIES WHO HAVE MADE THAT TOUGH JOURNEY TO SUCCESSFULLY REUNIFY WITH THEIR FAMILIES. THANK YOU. [APPLAUSE.] NOW. ALL RIGHT. WE'RE GOING TO DO THE AGENDA NOW. MADAME EXECUTIVE OFFICER, YOU'RE IN CHARGE FOR A MINUTE. 

SACHI HAMAI, EXEC. OFFICER: THANK YOU, MR. CHAIRMAN, GOOD MORNING, MEMBERS OF THE BOARD. WE WILL BEGIN TODAY'S AGENDA ON PAGE 2, PRESENTATION AND SET MATTERS. ON ITEM S-1, AS INDICATED ON THE POSTED AGENDA, THE DISTRICT ATTORNEY REQUESTS THAT THIS ITEM BE CONTINUED TO OCTOBER 7, 2014. 

SUP. KNABE, CHAIRMAN: SO ORDERED. 

SACHI HAMAI, EXEC. OFFICER: ON PAGE 3, AGENDA FOR THE MEETING OF THE BOARD OF DIRECTORS OF SANITATION DISTRICT NO. 27, ITEM NO. SD-1, THAT ITEM IS BEFORE YOU. 

SUP. KNABE, CHAIRMAN: MOVED BY SUPERVISOR RIDLEY-THOMAS. THE CHAIR WILL SECOND. WITHOUT OBJECTION, SO ORDERED. 

SACHI HAMAI, EXEC. OFFICER: PAGE 4 AGENDA FOR THE MEETING OF THE COMMUNITY DEVELOPMENT COMMISSION, ITEMS 1-D THROUGH 3-D. ON ITEMS 1-D AND 2-D, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THESE ITEMS. 3-D IS BEFORE YOU. 

SUP. KNABE, CHAIRMAN: THE CHAIR WILL MOVE IT. SECONDED BY SUPERVISOR MOLINA WITHOUT OBJECTION, SO BE THE ORDER. 

SACHI HAMAI, EXEC. OFFICER: PAGE 5, AGENDA FOR THE MEETING OF THE HOUSING AUTHORITY, 1-H AND 2-H. ON THESE ITEMS, THEY ARE BOTH BEFORE YOU. 

SUP. KNABE, CHAIRMAN: MOVED BY SUPERVISOR RIDLEY-THOMAS. SECOND. WITHOUT OBJECTION. SO ORDERED. 

SACHI HAMAI, EXEC. OFFICER: PAGE 6, AGENDA FOR THE MEETING OF THE REGIONAL PARK AND OPEN SPACE DISTRICTS, ITEMS 1-P AND 2-P. THESE ITEMS ARE BEFORE YOU. 

SUP. KNABE, CHAIRMAN: ON THESE TWO ITEMS THE CHAIR WILL MOVE IT, SECONDED BY SUPERVISOR MOLINA. WITHOUT OBJECTION, SO ORDERED. 

SACHI HAMAI, EXEC. OFFICER: ON PAGE 7 BOARD OF SUPERVISORS, ITEMS 1 THROUGH 14, ON ITEM NO. 2, SUPERVISOR MOLINA REQUESTS THAT THIS ITEM BE CONTINUED ONE WEEK TO SEPTEMBER 16. 

SUP. KNABE, CHAIRMAN: SO ORDERED. 

SACHI HAMAI, EXEC. OFFICER: ON ITEM NO. 6, SUPERVISOR KNABE REQUESTS THAT THIS ITEM BE CONTINUED TWO WEEKS TO SEPTEMBER 23, 2014. AND THE REMAINING ITEMS UNDER THE BOARD OF SUPERVISORS ARE BEFORE YOU. 

SUP. KNABE, CHAIRMAN: ON THE REMAINDER, MOVED BY SUPERVISOR MOLINA. THE CHAIR WILL SECOND. WITHOUT OBJECTION, SO ORDERED. 

SACHI HAMAI, EXEC. OFFICER: ON PAGE 11, CONSENT CALENDAR, ITEMS 15 THROUGH 41. ON ITEM NO. 16, SUPERVISOR KNABE REQUESTS THAT THIS ITEM BE HELD. ON ITEM NO. 21, SUPERVISOR RIDLEY-THOMAS REQUESTS THAT THIS ITEM BE CONTINUED ONE WEEK TO SEPTEMBER 16, 2014. 

SUP. KNABE, CHAIRMAN: SO ORDERED. 

SACHI HAMAI, EXEC. OFFICER: ON ITEM NO. 22, SUPERVISOR KNABE REQUESTS THAT THIS ITEM BE CONTINUED TWO WEEKS TO SEPTEMBER 23, 2014. 

SUP. KNABE, CHAIRMAN: SO ORDERED. 

SACHI HAMAI, EXEC. OFFICER: ON ITEM NO. 25, THE INTERIM DIRECTOR OF PUBLIC HEALTH REQUESTS THAT THIS ITEM BE DIRECTED BACK TO HER DEPARTMENT. 

SUP. KNABE, CHAIRMAN: SO ORDERED. 

SACHI HAMAI, EXEC. OFFICER: ON ITEM NO. 26, SUPERVISOR KNABE REQUESTS THAT THIS BE CONTINUED ONE WEEK TO SEPTEMBER 16, 2014, AND THE REMAINING ITEMS ARE BEFORE YOU. 

SUP. KNABE, CHAIRMAN: MOVED BY SUPERVISOR RIDLEY-THOMAS, THE CHAIR WILL SECOND. WITHOUT OBJECTION SO BE THE ORDER. 

SACHI HAMAI, EXEC. OFFICER: ON PAGE 23, ORDINANCE FOR INTRODUCTION, ITEM NUMBER 42 AND I'LL READ THE SHORT TITLE IN FOR THE RECORD. THIS IS AN ORDINANCE FOR INTRODUCTION AMENDING COUNTY CODE TITLE 6, SALARIES, SECTION 6.52.010 TO REFLECT THE NAME CHANGE FOR THE DEPARTMENT OF CORONER AND OFFICE OF MANAGED- CARE DIVISION WITHIN THE DEPARTMENT OF HEALTH SERVICES AND ADDING, DELETING AND OR CHANGING CERTAIN CLASSIFICATIONS AND NUMBERS OF ORDINANCE POSITIONS THIS IS THE VARIOUS DEPARTMENTS. IN ITEM IS BEFORE YOU. 

SUP. KNABE, CHAIRMAN: MOVED BY SUPERVISOR RIDLEY-THOMAS. SECONDED BY SUPERVISOR MOLINA. WITHOUT OBJECTION, SO ORDERED. 

SACHI HAMAI, EXEC. OFFICER: ON PAGE 24, DISCUSSION ITEM, ITEM NO. 43. AS INDICATED ON THE POSTED AGENDA, THE CHIEF EXECUTIVE OFFICER REQUESTS THAT THIS ITEM BE CONTINUED TO OCTOBER 7, 2014. 

SUP. KNABE, CHAIRMAN: SO ORDERED. 

SACHI HAMAI, EXEC. OFFICER: PAGE 25, MISCELLANEOUS ADDITIONS TO THE AGENDA WHICH WERE POSED MORE THAN 72 HOURS IN ADVANCE OF THE MEETING AS INDICATED ON THE SUPPLEMENTAL AGENDA. ON ITEM NO. 44-A, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. AND ITEM NO. 44-B IS BEFORE YOU. 

SUP. KNABE, CHAIRMAN: CHAIR WILL MOVE IT. SECONDED BY SUPERVISOR MOLINA. WITHOUT OBJECTION, SO ORDERED. 

SACHI HAMAI, EXEC. OFFICER: AND THAT COMPLETES THE READING OF THE AGENDA. BOARD OF SUPERVISORS SPECIAL ITEMS BEGIN WITH SUPERVISORIAL DISTRICT NO. 4. 

SUP. KNABE, CHAIRMAN: OKAY. OKAY. CALL UP ITEM NO. 2-D, ARNOLD SACHS. 

ARNOLD SACHS: ARNOLD SACHS. 2-D REFERS TO SOUNDPROOFING, WHICH IS PROBABLY A GREAT IDEA. MY CONCERNS ARE THE FUNDS THAT COME FROM LAWA, OVER $1 MILLION THAT ARE INCLUDED IN THIS SOUNDPROOFING. YOU KNOW, SEVERAL MONTHS AGO, THERE WAS A SITUATION IN THE CITY WITH THIS NEW APPLICATION FOR THESE COMPANIES THAT YOU CAN USE YOUR IPHONE OR I, WHATEVER, TO CONTACT FOR TRANSPORTATION. AND ONE OF THE PRESIDENTS OF ONE OF THE CAB COMPANIES MENTIONED THAT IT'S UNFAIR THEY CAN COME TO THE AIRPORT AND PICK UP PEOPLE, BUT THEY DON'T PAY THE FEE. LAWA CHARGES A CAB, TAXICAB, $4 TO PICK UP A PASSENGER AT THE TERMINALS. AND THE PERSON WHO WAS TALKING, I BELIEVE HIS NAME WAS MR. ROUSE, MENTIONED THAT OF THAT $4, $2 GOES TO THE CAB COMPANY. BUT THAT'S PUBLIC FUNDING. OR IT SHOULD BE GOING TO LAWA, IT SHOULD BE SOME KIND OF AIRPORT FUNDING. PEOPLE ARE PAYING TO GET IN THE TAXICAB A $4 SURCHARGE AND $2 ENDS UP GOING BACK TO THE CAB COMPANY INSTEAD OF USING THAT $2 TO GO FOR LIKE SOUNDPROOFING OR PUBLIC TRANSPORTATION. AND I KNOW THE BOARD HAS INTERESTS. I'VE HEARD SUPERVISOR ANTONOVICH MENTION THAT LAWA IS LIKE VISITING A THIRD WORLD AIRPORT, THIRD WORLD COUNTRY AIRPORT. SO THAT BEING SAID, HOW CAN YOU ALLOW A PRIVATE INDUSTRY TO GET $2 PER PASSENGER WHEN YOU HAVE A SUPERVISOR THAT SAYS THE AIRPORT'S LIKE VISITING A THIRD WORLD COUNTRY? AREN'T ARE YOU CONCERNED ABOUT THAT? DOESN'T THAT RAISE A LEVEL OF INTEREST TO YOU? I MEAN, I'M JUST A PUBLIC PERSON HERE. BUT I LISTEN TO SUPERVISOR ANTONOVICH. AND HE MENTIONS THAT MORE THAN ONE TIME IN MEETINGS. YOU HAVE TRANSPORTATION ISSUES FOR PUBLIC TRANSPORTATION. A DISCONNECT BETWEEN TRANSPORTATION AND THE INTERIOR OF THE AIRPORT. AND YET YOU'RE GIVING ALLOWING $2 BY THE AIRPORT COMMISSION OR WHATEVER TO GO TO A PRIVATE COMPANY. HOW DOES THAT MAKE SENSE? YOU WANT IT TO BE BUSINESS FRIENDLY FOR THE REST OF THE COUNTY, WHY DON'T YOU LET OTHER PUBLIC/PRIVATE INDUSTRIES, PRIVATE COMPANIES GET $2 APIECE? FIGURE SOMETHING OUT. IF IT COULD WORK AT THE AIRPORT, IT CAN CERTAINLY WORK AT THE REST OF THE COUNTY. I'M SURPRISED YOU HAVEN'T LOOKED INTO THAT SITUATION TO HELP MAKE MORE, L.A. MORE BUSINESS FRIENDLY. I MEAN, YOU'RE TALKING ABOUT 2, $3 MILLION A YEAR, THAT'S A LITTLE BIT OF MONEY. SOUNDPROOF THAT. 

SUP. KNABE, CHAIRMAN: OKAY. THAT ITEM IS BEFORE US. THE CHAIR WILL MOVE IT. SECONDED BY SUPERVISOR MOLINA. WITHOUT OBJECTION, SO ORDERED. ITEM 1-D, STEPHANIE KLASKY-GAMER. 

STEPHANIE KLASKY-GAMER: GOOD MORNING, SUPERVISORS, I'M STEPHANIE KLASKY-GAMER, THE PRESIDENT AND C.E.O. OF L.A. FAMILY HOUSING, A HOMELESS SERVICE AGENCY THAT HAS BEEN FORTUNATE TO WORK REALLY IN ALL OF YOUR DISTRICTS AND APPRECIATES ALL OF THE SUPPORT THAT YOU HAVE EACH GIVEN TO OUR ORGANIZATION TO HELP END HOMELESSNESS IN FAMILIES'S LIVES. I REALLY JUST WANTED TO SPEAK IN FAVOR OF 1-D AND TO THANK SUPERVISOR YAROSLAVSKY FOR THIS LEGACY SUPPORT FOR US TO REHAB ONE OF OUR LARGEST HOMELESS SHELTERS IN THE SAN FERNANDO VALLEY. THANK YOU VERY MUCH. 

SUP. KNABE, CHAIRMAN: THANK YOU. WE'LL PASS THAT ON TO SUPERVISOR YAROSLAVSKY. WITH THAT, THE CHAIR WILL MOVE IT. SECONDED BY SUPERVISOR RIDLEY-THOMAS, WITHOUT OBJECTION, SO BE THE ORDER. NEXT IS ITEM 44-A, DR. GENEVIEVE CLAVREUL. 

DR. GENEVIEVE CLAVREUL: GOOD MORNING, BOARD OF SUPERVISORS, DR. GENEVIEVE CLAVREUL. I'M VERY GLAD TO SEE THAT THE COUNTY IS FINALLY GIVING SOME MONEY TO THE T.H.E. CLINIC, THAT THE CLINIC HAS DONE QUITE A BIT OF WONDERFUL WORK, ESPECIALLY FOR WOMAN AND H.I.V. AND SO ON. SO I AM VERY GLAD THAT YOU ARE GIVING SOME MONEY. AND MAYBE YOU COULD HAVE GIVEN EVEN A LITTLE MORE. THANK YOU. 

SUP. KNABE, CHAIRMAN: HEAR THAT? SHE ASKED FOR MORE MONEY. RIGHT. ALL RIGHT. WITH THAT, THE CHAIR WILL MOVE IT. SECONDED BY SUPERVISOR RIDLEY-THOMAS. WITHOUT OBJECTION, SO ORDERED. I HELD ITEM NO. 16. I'M NOT SURE, MR. FUJIOKA, IS THIS YOUR OPERATION OR SOMEONE UNDERNEATH YOU? I DO HAVE SOME QUESTIONS ABOUT THE PURPOSE BEHIND ADDING AN ADDITIONAL LAYER OF APPROVAL WITH REQUIRING APPROVALS BY OUR COUNTY PROJECT MANAGER FOR OUR FILM PERMIT ISSUANCE. I MEAN, MY POINT IS I MEAN WE'VE TALKED ABOUT THIS 1,000 TIMES. I'VE SENT MEMOS DOWN THERE TO ANALYZE VARIOUS FEES AND THEY TELL ME THAT I AM ABSOLUTELY CORRECT. WE HIRE THE MOST. AND YET WE CONTINUE TO SPEAK ABOUT WANTING TO BE COOPERATIVE WITH THE INDUSTRY IN KEEPING IT HERE. BUT, I MEAN, WITH THIS RECOMMENDATION AND THE COUNTY PROJECT MANAGER, ARE WE CREATING A SOLUTION TO A PROBLEM? OR DO WE HAVE A SOLUTION THAT'S IN SEARCH OF A PROBLEM BY CREATING ANOTHER LAYER? MAYBE YOU COULD COMMENT. 

C.E.O. FUJIOKA: LET ME START. THERE WAS A CHALLENGE SEVERAL YEARS AGO BY AN OUTSIDE ATTORNEY. AS A CONSEQUENCE OF THAT CHALLENGE, WE DETERMINED WITH THE ASSISTANCE OF OUR COUNTY COUNSEL, THAT AS A CONTRACTING AGENCY, FILM L.A. CANNOT LEGALLY ISSUE CONTRACTS IN OUR BEHALF. AND SO THIS, WHAT WE'RE RECOMMENDING TODAY IS A PROCESS THAT WE FEEL WILL BE -- WILL MEET THE LEGAL REQUIREMENT. WE ALSO FEEL THAT WILL BE DONE IN AN EFFICIENT MANNER WHERE THE FILM L.A. BY USING THE COUNTY APP WILL BE ABLE TO POST THE REQUESTS ON THE APP, THAT WOULD BE MANAGED BY PUBLIC WORKS. AND WE WILL QUICKLY, WE ANY WE CAN DO THIS WITHIN NO MORE THAN ONE TO TWO HOURS, APPROVE THE QUESTIONS. SO IT BECOMES A COUNTY ACTION APPROVING THE PERMIT AND NOT AN OUTSIDE CONTRACTOR. IT'S JUST MEETING THE LEGAL REQUIREMENTS. 

SUP. KNABE, CHAIRMAN: HOW MANY ARE SIGNED UP WITH FILM L.A.? 

C.E.O. FUJIOKA: THE PROCESS I JUST DESCRIBED IS A PROCESS THAT IS ALSO USED BY THE CITY OF L.A. DO YOU KNOW THAT, FRANK, HOW MANY CITIES ARE SIGNED UP WITH FILM L.A.? 

SPEAKER: I BELIEVE FILM L.A. HAS CONTRACT WITH APPROXIMATELY 10 CITY AGENCIES WITHIN THE COUNTY. 

C.E.O. FUJIOKA: I UNDERSTAND A SIGNAL FROM THE BACK IT'S ACTUALLY WITH THE 16 CITIES IN L.A. COUNTY. 

SUP. KNABE, CHAIRMAN: WHAT CAN WE DO TO ASSIST IN GETTING MORE CITIES ON BOARD? 

C.E.O. FUJIOKA: WE CAN HAVE THE DIALOGUE THROUGH THE TWO ENTITIES THAT REPRESENT THE CITIES IN L.A. AT YOUR REQUEST, WE CAN INITIATE THAT DIALOGUE WITH BOTH OUR INDEPENDENT CITIES AND THOSE WHO WE WORK WITH ON A CONTRACTUAL BASIS. 

SUP. KNABE, CHAIRMAN: I THINK THAT WOULD BE IMPORTANT. 

C.E.O. FUJIOKA: I AGREE. 

SUP. KNABE, CHAIRMAN: TO BE AN ENCOURAGER. WE'VE CONDUCTED REVIEWS AND STUDIES OF COUNTY FEES VERSUS THE CITY FEES. THE COUNTY'S FEES WERE HIGHER IN EVERY INSTANCE. AS I MENTIONED EARLIER, TALK ABOUT BEING FILM-FRIENDLY, SHOULDN'T OUR FEES ALIGN WITH THE CITY'S OR A KIND OF A CONVERSATION GOING ON TO MAKE IT A BETTER PLACE TO DO BUSINESS IN THE INDUSTRY? BECAUSE RIGHT NOW WE HAVE A PATCHWORK OF FEES. AND I THINK THAT'S WHAT MAKES US VULNERABLE TO LOSING COMPETITIVE TYPES OF OPPORTUNITIES FOR FILMING, BOTH MOVIES AS WELL AS TV SERIES HERE IN THE COUNTY OF L.A. IS THAT DIALOGUE TAKING PLACE? 

SPEAKER: YES, SUPERVISOR. WE ACTUALLY ARE HOLDING SEMIANNUAL MEETINGS WITH THE FILM INDUSTRY REPRESENTATIVES. 

SUP. KNABE, CHAIRMAN: SEMIANNUAL. THAT'S A LONG WAY APART. 

C.E.O. FUJIOKA: WE'LL ALSO INVITE YOUR SUGGESTION THAT REPRESENTATIVES FROM THE TWO FORMAL ENTITIES WHO REPRESENT THE CITIES AND LOS ANGELES AND START THAT DIALOGUE. 

SUP. KNABE, CHAIRMAN: SOONER IS RATHER BETTER; MAYBE WE CAN HAVE A REPORT BACK EVERY 60 DAYS OR SOMETHING AS TO THE ACTIONS TAKING PLACE AND THE CONVERSATIONS TAKING PLACE AND TRYING TO STANDARDIZE FEES AND TRYING TO GET MORE CITIES. AND WITH THAT I'D MOVE THE ITEM WITH THAT ADDITIONAL RECOMMENDATION. ARE THERE ANY OTHER COMMENTS FROM MY COLLEAGUES? 

C.E.O. FUJIOKA: WE'LL START THAT DIALOGUE IMMEDIATELY. 

SUP. KNABE, CHAIRMAN: OKAY. ALL RIGHT. WITHOUT OBJECTION, SO ORDERED. 

SACHI HAMAI, EXEC. OFFICER: MR. CHAIRMAN, ON ITEM NO. 2, THIS ITEM WAS APPROVED TO BE CONTINUED FOR ONE WEEK, BUT IT'S BEING ASKED TO BE RECONSIDERED AND TAKEN UP TODAY. 

SUP. KNABE, CHAIRMAN: OKAY. MOVE RECONSIDERATION. THE ITEM'S BEFORE US. MOVED BY SUPERVISOR MOLINA. THE CHAIR WILL SECOND. ANY OBJECTION? SO ORDERED. 

SACHI HAMAI, EXEC. OFFICER: THANK YOU. 

SUP. KNABE, CHAIRMAN: ARE THERE ANY OTHER ITEMS ON THE AGENDA, IF NOT I'LL DO ADJOURNMENTS. 

SACHI HAMAI, EXEC. OFFICER: ADJOURNMENTS. 

SUP. KNABE, CHAIRMAN:OKAY. I'D LIKE TO ADJOURN IN MEMORY OF A VERY GOOD FRIEND HOWARD ABRAMS, A LONG BEACH RESIDENT WHO PASSED AWAY ON SEPTEMBER 2ND. HE WAS 72. HE WAS VERY ACTIVE WITH LOCAL CHAMBERS AND VARIOUS COMMUNITY ORGANIZATIONS. HE WAS A VICTIM OF WEST NILE. ONE OF THE FIRST ONES HERE IN OUR COUNTY. ABSOLUTELY A SHOCK TO ALL OF US. HE WILL BE MISSED BY ALL WHO KNEW HIM AND WORKED WITH HIM. GREAT COMMUNITY CITIZEN. ALSO ADJOURN IN MEMORY OF DR. GAIL ANDERSON SR. WHO SERVED AS THE COUNTY'S DIRECTOR OF EMERGENCY MEDICINE FROM 1971 TO 2002 WHO PASSED AWAY RECENTLY. HE WAS THE DIRECTOR OF OBSTETRICS AND GYNECOLOGY AT L.A.C.+U.S.C. IN 1971 WHEN HE WAS ASKED TO HEAD UP THE EMERGENCY DEPARTMENT. HE IS CREDITED WITH CREATING THE FIRST MEDICAL SCHOOL TRAINING PROGRAM IN EMERGENCY MEDICINE WHICH WAS THE FIRST OF ITS KIND IN THE NATION. 1979 THANKS IN LARGE PART TO DR. ANDERSON'S SUCCESSFUL PROGRAM, THE STUDY OF EMERGENCY MEDICINE WAS OFFICIALLY RECOGNIZED AS A MEDICAL SPECIALTY IN MEDICAL SCHOOLS ACROSS THE NATION. HE CONTINUED HIS LEADERSHIP FOR THE DEPARTMENT FOR THE NEXT 31 YEARS, EVENTUALLY BUILDING THE TRAINING PROGRAM TO 72 RESIDENTS AND CREATING THE FOUNDATION FOR THE SUCCESSFUL RESIDENCY PROGRAM THAT WE HAVE TODAY. HE WILL BE MISSED BY ALL WHO KNEW HIM. ALL MEMBERS. ALSO THAT WE ADJOURN IN MEMORY OF WILLIAM ANDRIZI, BROTHER-IN-LAW OF GWEN ANDRIZZI WHO USED TO WORK FOR THE C.E.O.'S OFFICE, PASSED AWAY ON AUGUST 29TH. BILL IS SURVIVED BY HIS THREE BROTHERS, JIM, NICK, ROSS AND SISTER SERENA. WE WANT TO EXTEND OUR DEEPEST AND MOST SINCERE CONDOLENCES TO GWEN AND THE ENTIRE ANDRIZZI FAMILY. AND THEN THE FOLLOWING ARE ADJOURNMENTS ON BEHALF OF SUPERVISOR ANTONOVICH. BEN L. SCHMID, A LONGTIME RESIDENT OF SAN MARINO. SERVED AS PRESIDENT OF THE STRUCTURAL ENGINEERS ASSOCIATION OF CALIFORNIA, SURVIVED BY HIS WIFE JEANNE AND THEIR FOUR CHILDREN. CHARLIE POWELL, FORMER N.F.L. PLAYER AND PROFESSIONAL BOXER, PLAYED WITH THE 49ERS IN OAKLAND. HE PASSED AWAY AT THE AGE OF 82. SURVIVED BY HIS WIFE ERMA AND THREE BROTHERS, ART, JERRY AND ELSWORTH. ALSO ADJOURN IN MEMORY OF JUDGE HARRY PEETRIS, RETIRED JUDGE OF THE LOS ANGELES SUPERIOR COURT, WHO PASSED AWAY AT THE AGE OF 94. GRADUATED FROM U.S.C. HE ALSO BEGAN HIS CAREER AS AN F.B.I. SPECIAL AGENT. SERVED 52 YEARS ON THE CALIFORNIA STATE AND FEDERAL COURTS. HE IS SURVIVED BY HIS THREE CHILDREN. ALSO THAT WE ADJOURN IN MEMORY OF MARIA ORTON, LONGTIME RESIDENT OF THE ANTELOPE VALLEY WHO PASSED AWAY AT THE AGE OF 81, SURVIVED BY HER HUSBAND WILLIAM, TWO CHILDREN. WE ADJOURN IN MEMORY OF KATHLEEN MALONEY, LONGTIME RESIDENT OF SANTA CLARITA, PASSED AWAY AT THE YOUNG AGE OF 65. SHE SERVED AS EXECUTIVE DIRECTOR OF THE COLLEGE OF CANYONS FOUNDATION FOR 18 YEARS. SHE IS SURVIVED BY HER THREE CHILDREN AND FIVE SIBLINGS. ALSO THAT WE ADJOURN IN MEMORY OF THOMAS LEBRUN, PASSED AWAY SEPTEMBER 4TH. HE WAS AN ENGINEER WITH THE COUNTY, FACILITIES PLANNING DEPARTMENT, SANITATION DISTRICT FOR 40 YEARS. HE ALSO OVERSAW THE STATE-OF-THE-ART WATER TREATMENT FACILITIES IN THE ANTELOPE VALLEY. SURVIVED BY HIS WIFE JENNIFER AND HIS THREE CHILDREN. ALSO WE ADJOURN IN MEMORY OF FRANK JUNG WHO PASSED AWAY AT THE AGE OF 92. GRADUATE OF U.S.C. AND VOLUNTEER IN THE UNITED STATES AIR FORCE AS A RADIO OPERATOR DURING WORLD WAR II. HE WAS VERY ACTIVE MEMBER OF THE COMMUNITY ORGANIZATIONS INCLUDING THE CHINESE-AMERICAN CITIZEN ALLIANCE, CHINESE FAMILY FOUR ASSOCIATION REPUBLICAN PARTY. HE IS SURVIVED BY HIS TWO SONS. ALSO THAT WE ADJOURN IN MEMORY OF MARCH SCHWARTZ, FOUNDER AND PUBLISHER OF THE "BEVERLY HILLS COURIER" WHO PASSED AWAY AT THE AGE OF 97. HE SERVED IN THE ARMY DURING WORLD WAR II, BECAME AN AID TO LIEUTENANT JOSEPH STILLWELL IN CHINA. HE WAS NAMED MAN OF THE YEAR BY THE BEVERLY HILLS EDUCATION FOUNDATION, CITIZEN OF THE YEAR BY THE CHAMBER OF COMMERCE, SURVIVED BY HIS WIFE LINDA AND SEVEN CHILDREN. ALSO WE ADJOURN IN MEMORY OF JUSTICE H. WALTER CROSKEY WHO SERVED ON CALIFORNIA'S COURT OF APPEALS SECOND DISTRICT THIRD DIVISION WHO PASSED AWAY RECENTLY AT THE AGE OF 81. HE GRADUATED FROM U.S.C., BEGAN HIS CAREER AS A U.S. NAVY JAG CORPS AND BEGAN SUCCESSFUL PRIVATE PRACTICE AND APPOINTED TO SUPERIOR COURT BY GOVERNOR DEUKMEJIAN IN 1984 AND ELEVATED TO THE COURT OF APPEALS. I'D LIKE TO BE ON THAT, AS WELL. AND THEN FINALLY JOAN RIVERS, ACCLAIMED COMEDIAN, TV PERSONALITY WHO PASSED AWAY AT THE AGE OF 81, ALL MEMBERS. SHE BEGAN HER CAREER IN COMEDY CLUBS IN GREENWICH VILLAGE, ROSE TO NATIONAL PROMINENCE AS A GUEST AND GUEST HOST AS WE ALL KNOW ON THE "TONIGHT SHOW." SHE'S HAD HER OWN LATE NIGHT SHOW AND WON AN EMMY. SHE WAS A SUCCESSFUL ENTREPRENEUR, SHE HAD HER OWN JEWELRY AND FASHION LINE. PROLIFIC PHILANTHROPIST FOR NOTEWORTHY CAUSES INCLUDING SUICIDE PREVENTION AND WAS A STAUNCH SUPPORTER OF ISRAEL. SHE IS SURVIVED BY HER DAUGHTER MELISSA AND GRANDSON EDGAR COOPER AND THAT'S ALL MEMBERS. OKAY. I HAVE ONE ON BEHALF OF SUPERVISOR YAROSLAVSKY, AS WELL. AND THAT'S MICHAEL MARCY, LONG- TIME RESIDENT OF THE THIRD DISTRICT. AND A GOOD FRIEND TO HIS OFFICE WHO PASSED AWAY RECENTLY. HE ESCAPED TO AMERICA IN 1940, EVENTUALLY SETTLING IN LOS ANGELES. HE WAS A PRODUCT OF BEVERLY HILLS SCHOOLS, POMONA COLLEGE, PENN MEDICAL SCHOOL. BECAME A PEDIATRICIAN AND PRACTICED FOR MANY YEARS ON THE EAST COAST BEFORE RETURNING TO LOS ANGELES IN 1973. HE WAS OUT OF KAISER PERMANENTE AND PANORAMA CITY AND CHILDREN'S HOSPITAL UNTIL HE RETIRED. HE AND HIS WIFE JOAN WERE ACTIVE IN THE COMMUNITY OFFERED VALUED PERSPECTIVE ON MANY ISSUES AFFECTING THEIR HOMEOWNER ASSOCIATION. HE IS SURVIVED BY HIS WIFE JOAN, TWO CHILDREN, STEPHANIE AND JOSH, AND TWO GRANDCHILDREN. WITH ALL THOSE, SO ORDERED. SUPERVISOR MOLINA? 

SUP. MOLINA: (OFF MIC). [REV. RENE] LEDESMA, A LONGTIME NORTHEAST RESIDENT. REVEREND LEDESMA ADVOCATED TIRELESSLY FOR SOCIAL JUSTICE TO HIS SERVICE WITH THE PLAZA COMMUNITY CENTER, THE GENERAL BOARD OF GLOBAL MINISTRIES AND THE WALL LAS MEMORIAS PROJECT, FAITH ADVISORY BOARD AND AS PASTOR AND TEACHER. HE WAS A STAUNCH ADVOCATE OF THE L.G.B.T. COMMUNITY AND HIS MANY GOOD WORKS TOUCHED COUNTLESS LIVES. WE WANT TO EXTEND OUR THOUGHTS AND PRAYERS TO HIS FAMILY, HIS FRIENDS AS WELL AS HIS FORMER COLLEAGUES. IT IS WITH GREAT SADNESS THAT WE ADJOURN IN MEMORY OF DR. ISMAEL NUNO WHO SERVED AS ASSISTANT PROFESSOR OF CLINICAL CARDIOTHORACIC SURGERY HERE AT KECK HOSPITAL AT U.S.C. AS WE ALL KNOW HE WAS A REMARKABLE PUBLIC SERVANT. HE NEVER FAILED TO ASSIST WITH PATIENT ADVOCACY ISSUES WHEN CALLED UPON. HE SAVED MANY LIVES, REMAINED SENSITIVE TO THE NEEDS OF OUR COMMUNITIES. HE WILL BE DEEPLY MISSED BY MANY COLLEAGUES AND CERTAINLY MANY ADMIRERS. WE HONORED HIM HERE WHEN HE RETIRED SEEMS LIKE ONLY SIX OR EIGHT MONTHS AGO, AND HE WAS SOMEBODY WHO WAS TRULY LOVED BY EVERYBODY IN THE COMMUNITY. CERTAINLY AND I'D ALSO ASK THAT WE ADJOURN IN MEMORY OF RONALD SHIGAKU TOMA, A LONGTIME LOS ANGELES RESIDENT AND FATHER OF ROBIN TOMA, THE EXECUTIVE DIRECTOR OF LOS ANGELES HUMAN RELATIONS COMMISSION. WE WANT TO EXTEND OUR DEEPEST CONDOLENCES TO THE FAMILY AND ALL MEMBERS IF THEY WOULD JOIN ME. VERY GOOD, THANK YOU. 

SUP. KNABE, CHAIRMAN: SUPERVISOR RIDLEY-THOMAS, ADJOURNMENTS? NONE? ALL RIGHT. WITH THAT WE'LL GO TO PUBLIC COMMENTS. IRENE PANG. ROBERT LUCAS. AND ARNOLD SACHS. IF YOU WILL JOIN US, PLEASE. 

IRENE PANG: I'M IRENE. I'M CONCERNED ABOUT MY HOUSE, THE SMALL HOUSE LOCATED IN LA MADAWAMA , THE ADDRESS IS 3129, LA MADAWAMA. THIS SMALL HOUSE HAVE BEEN SINCE LAST YEAR HAVE BEEN I BOUGHT THERE AND PAID FOR THE PAINTING AND BUY THE NEW HEATER BUT BEFORE THE CHRISTMAS. BUT STILL IT IS ILLEGAL (INAUDIBLE) AND PAYS IN AND OUT OF THE HOUSE WHEN I GET IN THEY TRY TO HURT ME AND ALSO THEY BUILD UP THE ADDITION HOUSE, BREAK THE DIVISION WALL, THE DIVISION WALL BETWEEN THE TWO NEIGHBOR AND THE ADDITION HOUSE AND THEY BOUGHT ON AND ALSO THE GARAGE AND I NOW AGAIN I ASK REQUIRE THE GOVERNMENT AND SAID TO THAT KIND OF SITUATION. AND SINCE THE LAST TIME IN THE MEASURE REMAIN TO THE MCDONALD'S SIDE IN THE RALLY'S, SHUNT, THE CITY EL MONTE DID NOT HANDLE AND TAKE THE COUNTY TO HANDLE THIS TIME. THE OTHER THING, THE SECOND THING I CONCERNED ABOUT IS THE SHOOTING IN THE RESIDENCE SAFETY. IN THE NIGHT TIME THEY COME RACING SHOOTING YELLING AND THE FEMALE IS YELLING ON THE STREET. AND I NEED TO THE PUBLIC AND THE GOVERNMENT GIVE THE HELP HAND TO THE VICTIM AND THEIR FAMILY AND PROTECT THE RESIDENT AND CITIZEN. AND PROTECT THE PRIVATE PROPERTY AND PUBLIC PROPERTY. THANK YOU. 

SUP. KNABE, CHAIRMAN: NEXT? 

ROBERT LUCAS: GOOD AFTERNOON, MY NAME IS ROBERT LUCAS. I'D LIKE TO MENTION I HAD THE SERGEANT AT ARMS DELIVER THE MISSION STATEMENT THAT I'VE BEEN WORKING ON. AND MR. RIDLEY-THOMAS, HIS OFFICE HOOKED ME UP WITH KATHLEEN AUSTRIA OF THE FIRESTONE AREA WITH THE MENTALLY ILL AND HOMELESS. THE ISSUE THAT I HAD ORIGINALLY ASKED TO ASSIST ME WITH HAD TO DO WITH THE PERSHING SQUARE INCIDENT BY ONE OF THE CITY EMPLOYEES. I KNOW I WAS KIND OF REACHING WHETHER IT WAS IN YOUR JURISDICTION. I JUST AM SO FRUSTRATED WITH THAT PERSON AND THE WAY THAT I WAS TREATED BY HER AS A REPRESENTATIVE OF LOS ANGELES THAT I'VE GONE THROUGH THE CITY COUNCIL AND BROUGHT IT HERE. THIS HAS BEEN ONGOING SINCE ABOUT AUGUST. ALSO, I JUST HAPPENED TO LOOK IN THE PAPER, THIS "DOWNTOWN NEWS" WITH CITY COUNCILMAN HUIZAR IS GOING TO BRING ON SEPTEMBER 29TH A MEETING LIKE A TOWN HALL MEETING ON THE HOMELESSNESS. AND SOME OF THE ISSUES GOING ON DOWNTOWN. I'LL ADRESS HIM TOMORROW. WHAT I WANTED TO DO IS ASK ALL OF YOU IN READING THIS MISSION STATEMENT, I REALIZE THAT THERE'S A LOT OF THINGS THAT I MAY BE REQUESTING ASSISTANCE FOR BECAUSE I'M NOT EXACTLY 100 PERCENT SURE OF SOME OF THE PROCEDURES THAT I NEED TO TRY TO MAKE THIS HAPPEN. I'VE ASKED FOR QUITE A BIT HOPING TO GET A LITTLE. SO ANOTHER ISSUE WITH THIS MENTALLY ILL DOWNTOWN, WITH THE CENTRAL DIVISION L.A.P.D., CAPTAIN OR LIEUTENANT MUNOZ AND SENIOR DEPUTY OFFICER DUTY OFFICER DEON JOSEPH, SOME OF THE WORK THAT I'VE EXPERIENCED SOME OF THE MEN AND WOMEN DOWN IN THAT AREA IN THE PAST TWO WEEKS HAS BEEN SOME OF THE MOST REMARKABLE HUMANITARIAN INTERACTION THAT I'VE SEEN BETWEEN L.A.P.D. AND ANYBODY ANYWHERE. I'M TALKING ABOUT CLERGY, FRIENDS. SOME OF THE ACTIONS AND INTERACTIONS BETWEEN SOME OF THE L.A.P.D. OFFICERS DOWN THERE TRULY TOUCHED ME IN SUCH A FASHION THAT TO NOT BRING THIS TO LIGHT WOULD BE COMPLETELY UNFAIR CONSIDERING SOME OF THE ISSUES THAT ARE SO WELL PUBLICIZED. SOME OF THE GENEROSITY AND KINDNESS THAT ARE INSTILLED ON SOME OF THESE MENTALLY HANDICAPPED PEOPLE DOWN THERE IS TRULY ANGELIC. 

SUP. KNABE, CHAIRMAN: THANK YOU. NEXT? 

ARNOLD SACHS: WHY, YES, THANK YOU. GOOD MORNING. ARNOLD SACHS. AND FASCINATING, ALTHOUGH THIS IS I FIND MYSELF HARD BELIEVING I'M GOING TO SAY THIS. I ACTUALLY AGREE. CHANGED MY POSITION WITH SUPERVISOR ANTONOVICH AND THE DECISION LAST WEEK. AND IT'S ABOUT THE LANGUAGE THAT YOU USE. REGARDING THE MONUMENTAL DESIGNATION FOR THE SAN GABRIEL MOUNTAINS. BECAUSE ACCORDING TO THE ARTICLE THAT WAS WRITTEN IN THE DAILY BREEZE THE DAY AFTER OR THE DAY BEFORE, IT WAS ACTUALLY GOING TO BE A NATIONAL RECREATION AREA. AND THEN ONE MONTH AGO, CONGRESSWOMAN CHU CHANGED THE LEGISLATION TO MAKE IT A NATIONAL MONUMENT. AND SO THE STUDIES THAT HAVE BEEN DONE THAT SHE ALLUDED TO AND THE PEOPLE THAT CAME UP AND TALKED ABOUT WERE STUDIES THAT WERE DONE REGARDING CREATING A NATIONAL RECREATION AREA. SO WHY THE CHANGE FROM A NATIONAL RECREATION AREA TO A NATIONAL MONUMENT? AND WHY NOT ALLOW FOR THE STUDY? AND THAT REALLY IS THE KEY. IT'S THE NUANCES IN THE LANGUAGE IN THE "DOWNTOWN NEWS," THERE WAS A STORY ABOUT CITY COUNCILS, A LITTLE COMIC. AND THEY WANT TO PAY FOR PEOPLE TO VOTE. AND THE LITTLE CHARACTER AT THE END SAYS "IF YOU COULD JUST GIVE THE PEOPLE SOMETHING TO VOTE FOR." SOMETHING TO VOTE FOR? HOW ABOUT SOMEONE TO VOTE FOR! INSTEAD OF THE SAME CROOKS THAT THEY ALWAYS SEEM TO ROLL OUT, THE SAME COMPANY LINE THAT WE'RE DOING GREAT, IT'S THE CITY OF ANGELS, THE COUNTY IS WONDERFUL, EVERYTHING IS GREAT, EXCEPT THE POPULATION IS SINKING LOWER AND LOWER INTO POVERTY. THE COUNTY'S BUDGET IN THE LAST FIVE YEARS HAS INCREASED BY $4 BILLION FROM OVER $22 BILLION TO OVER $26 BILLION. CAN YOU NAME $4 BILLION IN IMPROVEMENTS IN YOUR LIFE THAT WOULD SHOW UP FROM $4 BILLION INCREASE? I CAN'T. YOU KNOW, IT'S LIKE THIS STORY THAT HAPPENED WITH RAY RICE YESTERDAY. I'D LIKE TO HEAR SOME ANNOUNCEMENTS FROM THE COUNTY BOARD ON THAT. THIS IS FROM TODAY'S NEWSPAPER. "'WE REQUESTED FROM LAW ENFORCEMENT ANY AND ALL INFORMATION ABOUT THE INCIDENT INCLUDING A VIDEO FROM INSIDE THE ELEVATOR.' N.F.L. SPOKESMAN GREG AIELLO SAID MONDAY MORNING. THE VIDEO WAS NOT MADE AVAILABLE TO US AND NO ONE IN OUR OFFICE HAD SEEN IT UNTIL TODAY. "'. NO ONE IN THAT OFFICE, BUT YOU CAN BE SURE THERE WAS A FOUR-DAY DELAY BETWEEN WHEN THEY WERE INDICTED AND THE VIDEO WAS RELEASED, YOU CAN BE SURE THAT SOMEBODY FROM THE N.F.L. KNEW ABOUT IT IN THAT FOUR DAYS. YOU CAN BE SURE THAT A COUNTY PROSECUTOR WOULD HAVE KNOWN ABOUT IT. SO WHAT HAPPENED? WHO DROPPED THE BALL? WHO FUMBLED? THE GOVERNMENT OR THE N.F.L.? 

SUP. KNABE, CHAIRMAN: THANK YOU. DAVID SERRANO. 

DAVID SERRANO: GOD IS THE FATHER AND THE SON AND THE HOLY SPIRIT. THE LORD OUR GOD, THE LORD IS ONE, AMEN, HALLELUJAH. REALITY IS: INFINITE GOD ALMIGHTY JESUS CHRIST CREATED HEAVEN AND THE UNIVERSE, AMEN, PRAISE THE LORD. ETERNAL JESUS WAS CONCEIVED BY THE POWER OF THE HOLY SPIRIT OF GOD AND CHRIST WAS BORN OF THE SANCTIFIED VIRGIN MARY. JESUS CHRIST NEVER SINNED. JESUS CHRIST SPOKE THE WORD OF GOD AND HE FORGAVE PEOPLE'S SINS. THE LORD JESUS CURED LEPROSY. CHRIST GAVE SIGHT TO THE BLIND. THE ETERNAL SON OF GOD REALLY RAISED DEAD PEOPLE TO LIFE. INNOCENT JESUS WILLINGLY SHED HIS OWN SACRED, DIVINE BLOOD, AND CHRIST DIED FOR OUR SINS ON THE CROSS AS OUR SUBSTITUTE. HE WAS BURIED. AND THEN ON THE THIRD DAY, JESUS CHRIST RESURRECTED AND HE LEFT THE TOMB, AMEN, PRAISE THE LORD. CHRIST JESUS APPEARED TO HUNDREDS OF HIS DISCIPLES OVER THE COURSE OF 40 DAYS. JESUS CHRIST ASCENDED INTO HEAVEN. JESUS CHRIST IS AT THE RIGHT HAND OF INFINITE GOD THE FATHER ALMIGHTY IN THE KINGDOM OF THE MOST HIGH, AMEN, HALLELUJAH. WE RECEIVE LIFE EVERLASTING WITH GOD BY THE GRACE OF GOD ONLY BY BELIEVING REALITY, JESUS CHRIST IS GOD. CHRISTIAN SOULS AND SPIRITS ASCEND INTO THE KINGDOM OF HEAVEN, AMEN. CHRISTIANS HAVE LIFE EVERLASTING WITH GOD IN THE KINGDOM OF GOD, AMEN. UNBELIEVERS DIE AND RECEIVE THE PENALTY FOR THEIR OWN SINS. UNBELIEVERS DIE AND BURN IN SHEOL HADES. REPENT, THEREFORE, AND BELIEVE REALITY. JESUS CHRIST IS GOD. AND THEN YOU WILL HAVE LIFE EVERLASTING WITH GOD IN THE KINGDOM OF GOD, AMEN. GOD BLESS THE UNITED STATES OF AMERICA! 

SUP. KNABE, CHAIRMAN: THANK YOU FOR THAT BENEDICTION. AND NOW IF YOU'LL READ US INTO CLOSED SESSION. 

SACHI HAMAI, EXEC. OFFICER: IN ACCORDANCE WITH BROWN ACT REQUIREMENTS, NOTICE IS HEREBY GIVEN THAT THE BOARD OF SUPERVISORS WILL CONVENE IN CLOSED SESSION TO DISCUSS ITEMS NO. CS-1 CONFERENCE WITH LEGAL COUNSEL REGARDING SIGNIFICANT EXPOSURE TO LITIGATION ONE CASE AS INDICATED ON THE POSTED AGENDA, THANK YOU. 
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